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What's New

1 What's New

New features in ODBC Driver for MySQL 5.1

¢ Fixed connection timeout setting before opening connection
¢ Now passwords are stored in an encrypted form in the DSN record
e Added Read Only mode for connection

¢ Improved compatibility with FileMaker Server for Linux and macOS

New features in ODBC Driver for MySQL 5.0

¢ Added support for MariaDB 11

¢ Improved compatibility with 4D in macOS

New features in ODBC Driver for MySQL 4.4

e Added support for SELECT TOP clause for Linked Server in MSSMS
¢ Added support for SQL_ATTR_MAX_ROWS attribute

¢ Improved compatibility with Visual Basic in Visual Studio

New features in ODBC Driver for MySQL 4.3

e Added support for macOS 13 Ventura
¢ Improved compatibility with Tableau Prep Builder
¢ Improved compatibility with Crystal Reports

¢ Improved the SSH connection establishment

New features in ODBC Driver for MySQL 4.2

e Added support for Windows 11

e Added support for MariaDB 10.6

¢ Improved compatibility with FICO Mosel
¢ Improved compatibility with FileMaker

¢ Improved compatibility with JMP on macOS
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¢ Improved support for an ODBC installer on Windows 2000

New features in ODBC Driver for MySQL 4.1

e MSlinstaller for deploying through GPO is added

New features in ODBC Driver for MySQL 4.0

e Apple Silicon M1 is supported
e Compatibility with macOS Big Sur is improved

New features in ODBC Driver for MySQL 3.1

e Now ODBC driver is thread-safe

¢ Now ODBC driver activation does not require administrator privileges

e Work with password-protected private key for SSH protocol is supported
¢ Improved compatibility with sandboxed applications for macOS

e Support for connection pooling is improved

New features in ODBC Driver for MySQL 3.0

¢ Now ODBC driver for macOS is distributed as a PKG package
e Now ODBC driver for Linux is distributed as DEB and RPM packages
e Possibility to force the ODBC 2.x behavior is added

New features in ODBC Driver for MySQL 2.4

e MySQL 8 is supported

e Support for sha2_password, caching_sha2_password authentications is added
e Possibility to return String Types as Ansi or Unicode is added

e Compatibility with MS Access is improved

e Compatibility with Tableau is improved

e Compatibility with Omnis Studio is improved

e Compatibility with Power Pivot is improved
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e Compatibility with DBeaver is improved

New features in ODBC Driver for MySQL 2.3

¢ Performance of batch operations is significantly improved
¢ Retrieving metadata for MySQL 4.1.1 and lower is improved
¢ The SSHStoragePath connection parameter is added

e Query Timeout option is added

New features in ODBC Driver for MySQL 2.2

e Azure Database for MySQL is supported

e Compatibility with SAS JMP is improved

e Compatibility with MS Power Query is improved

e OUTER JOIN macros in SQL queries are supported
e DateTime macros in SQL queries are supported

e Scalar function macros in SQL queries are supported

New features in ODBC Driver for MySQL 2.1

e Compatibility with MS Visual Studio

e Compatibility with MS FoxPro is improved

e Compatibility with Maplnfo is improved

e Compatibility with Libre Office is improved

e Compatibility with Qlik is improved

e Compatibility with Delphi & C++Builder is improved

e MS Access linked tables support is improved

New features in ODBC Driver for MySQL 2.0

e Linux is supported
e macOS is supported

e Support for stored procedures and functions is improved
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e Backward compatibility of SQLExecDirect with ODBC 2.x is improved
e Compatibility with MS Excel is improved
e Compatibility with ODBC 2.x is improved

¢ Bug with Trial expiration in Microsoft SQL Server Management Studio is fixed

New features in ODBC Driver for MySQL 1.3

e Connection via SSL protocol is supported
e Connection via SSH protocol is supported
e Connection via HTTP tunnel is supported
e Compatibility with Power Bl Desktop is improved

e Compatibility with Microsoft Visual FoxPro is improved

New features in ODBC Driver for MySQL 1.2

e Compatibility with Microsoft Visual Studio is improved

e Compatibility with Microsoft Office is improved

e Compatibility with Microsoft SQL Server Management Studio is improved
e Compatibility with Crystal Reports is improved

e Compatibility with ClikView is improved

New features in ODBC Driver for MySQL 1.1

¢ Performance is improved

New features in ODBC Driver for MySQL 1.0

e First release of ODBC Driver for MySQL
e Windows 32-bit is supported
e Windows 64-bit is supported

© 2015-2024
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1. Overview

2. Features
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4. Requirements

5. Licensing
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Overview

Overview

Devart ODBC Driver for MySQL is a high-performance connectivity solution with enterprise-
level features for accessing MySQL, Microsoft Azure Database for MySQL, MariaDB, Amazon
RDS for MySQL, and Amazon Aurora databases from ODBC-compliant reporting, analytics,
Bl, and ETL tools on both 32-bit and 64-bit Windows, macOS, and Linux. Our ODBC driver
fully supports standard ODBC API functions and data types and enables easy and secure

access to live MySQL data from anywhere.

v ODBC API
ODBC Data -
Types

Direct Connection

Our data connector enables various ODBC-aware applications to establish a direct
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connection to MySQL via TCP/IP to eliminate the need for MySQL client. Direct connection
increases the speed of data transmission between an external application and MySQL for
real-time analytics. It also streamlines the deployment process, since there is no need to
distribute any additional client software with the driver.

Application

ODBC Interface m
TCP/IP

Driver Manager

MySQOL
Devart ODBC driver
for MySOL

Compatibility
The following MySQL versions are supported:
e MySQL server: 8.0, 6.0, 5.6, 5.5, 5.1, 5.0, 4.1, 4.0, 3.23

e MariaDB server up to 11.x

e Microsoft Azure Database for MySQL
e Amazon RDS for MySQL

e Amazon Aurora

e Google Cloud for MySQL

© 2015-2024
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2.2 Features

Application

ODBC Interface m
TCP/IP

Driver Manager
MySQL

Devart ODBC driver
for MySOL

Direct Connection

Database applications based on our solution get an opportunity to establish connection to
MySQL directly. Direct Connection gives your applications an unrivaled advantage -
connection to MySQL databases directly via TCP/IP. That improves performance of your
applications, their quality, reliability and especially the deployment process, since there is no
need to supply additional client software together with your application.

v ODBC API
ODBC Data -
Types

ODBC Conformance

Our ODBC driver provides full support for common ODBC interface:
e ODBC Data Types support
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e ODBC API Functions support

In addition, we provide support for Advanced Connection String parameters. Thus allowing
any desktop and web applications to connect to MySQL from various environments and
platforms, that support ODBC.

64

bit

32

bit

Development Platforms Variety

ODBC driver for MySQL doesn't limit your choice of the development platform and
environment. The driver installations are available for various operational systems and
platforms. The current version supports Windows, both 32-bit and 64-bit. So you can develop
both 32-bit and 64-bit cross-platform applications.

]
] I

—

Database Compatibility

ODBC Diriver for MySQL supports the following database servers:
e MySQL servers: 8.0, 6.0, 5.6, 5.5, 5.1, 5.0, 4.1, 4.0, and 3.23

e MySQL Embedded servers: 6.0, 5.6, 5.5, 5.1, 4.1, and 4.0
e MariaDB up to 11.x
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High Performance

All our products are designed to help you write high-performance, lightweight data access

layers, therefore they use advanced data access algorithms and techniques of optimization.

| v

Support
Visit our Support page to get instant help from knowledgeable and experienced professionals,

a quick resolution of your problems, and nightly builds with hotfixes.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

2.3 Compatibility

MySQL Compatibility
ODBC Driver for MySQL supports the following versions of the MySQL server:

8.0,6.0,5.7,5.6,5.5,5.1,5.0,4.1, 4.0, 3.23.

MariaDB Compatibility
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MariaDB server: 5.x-11.x.

Microsoft Azure Database for MySQL Compatibility

ODBC Driver for MySQL supports Microsoft Azure Database for MySQL.

Amazon RDS for MySQL Compatibility

ODBC Driver for MySQL supports Amazon RDS for MySQL and Amazon Aurora.

Google Cloud for MySQL Compatibility

ODBC Diriver for MySQL supports Google Cloud for MySQL.

Supported Platforms

¢ Windows x86 and x64 (including Windows Terminal Server)
e macOS x64 and ARM (Apple Silicon M1)
e Linux x86 and x64

Compatibility With Third-Party Tools

Application Development Tools

Adobe ColdFusion
Embarcadero Delphi & C++Builder

FileMaker
Lazarus

Microsoft Visual FoxPro

Microsoft Visual Studio

Omnis Studio

CIC SIS SIS LS

PHP
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PowerBASIC

<

Python

<

Database Management

Aqua Data Studio

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

SQL Server Reporting Services

CIC LS LS ]C K

Bl & Analytics Software

Alteryx

DBxtra

Dundas Bl

IBM SPSS Statistics

MicroStrategy

Power Bl

Qlik Sense

QlikView

CICIC L LS

1"
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2.5

RStudio

SAP Crystal Reports
SAS JMP

Tableau

TARGIT

A N N N SN

TIBCO Spotffire

Office Software Suites

LibreOffice
Microsoft Access
Microsoft Excel

OpenOffice

CIS SIS S

StarOffice

© 2015-2024
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Requirements

The following requirement must be met for ODBC Driver for MySQL.:

¢ Only one version of ODBC Driver for MySQL is installed on your system.

No additional client software is required on your system.

© 2015-2024
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Licensing

ODBC Diriver License Agreement
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PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement”) is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop
computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

© 2024 Enter your company name


https://www.devart.com/odbc/

14

ODBC Driver for MySQL

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
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of this Agreement. Usage of the Software is subject to the following restrictions.
2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written
permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
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you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.

© 2015-2024
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2.6

Reserved.

Getting Support

This document lists several ways you can find help with using ODBC Driver for MySQL
describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for
MySQL:
¢ You can find out more about ODBC Driver for MySQL installation or licensing by consulting

Installation and License articles of this manual respectively.

¢ You can get community assistance and technical support on the Community Forum.

¢ You can get advanced technical assistance by ODBC Driver for MySQL developers through

the ODBC Driver for MySQL Priority Support program.

Subscriptions

The ODBC Driver for MySQL Subscription program is an annual maintenance and support
service for ODBC Driver for MySQL users.

Users with a valid ODBC Driver for MySQL Subscription get the following benefits:
¢ Product support through the ODBC Driver for MySQL Priority Support program
¢ Access to new versions of ODBC Driver for MySQL when they are released

¢ Access to all ODBC Driver for MySQL updates and bug fixes

¢ Notifications about new product versions

Priority Support

ODBC Driver for MySQL Priority Support is an advanced product support service for getting
expedited individual assistance with ODBC Driver for MySQL-related questions from the
ODBC Driver for MySQL developers themselves. Priority Support is carried out over email
and has a two business day response policy. Priority Support is available for users with an
active ODBC Driver for MySQL Subscription.
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https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/mysql/

18

ODBC Driver for MySQL

To get help through the ODBC Driver for MySQL Priority Support program, please send an
email to odbc@devart.com describing the problem you are having. Make sure to include the

following information in your message:

Your ODBC Driver for MySQL Registration number.

e Full ODBC Driver for MySQL edition name and version number. You can find the version
number in DLL version information.

¢ Versions of the MySQL server and client you are using.

e A detailed problem description.

e |f possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for MySQL.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com

© 2015-2024
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3.1 Installation
ODBC Diriver for MySQL currently supports the following platforms: Windows, macOS, and
Linux, both 32-bit and 64-bit.

See how to install Devart ODBC Driver for MySQL :

e \Windows

¢ Windows Silent

e macOS
e Linux DEB
e Linux RPM

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

3.1.1 Windows

Installation

1. Download and run the installer.

2. Follow the instructions in the wizard.

© 2024 Enter your company name


https://www.devart.com/company/contactform.html?category=0&product=odbc/mysql
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/mysql/feedback.html
https://www.devart.com/odbc/mysql/download.html

20

ODBC Driver for MySQL

i¥ setup - Devart ODBC Driver for MySQL — >
devo r‘t Welcome to the Devart ODBC Driver for
MySQL Setup Wizard
This will install Devart ODBC Driver for MySQL 3.1, 2 on your
computer,

It is recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

WARNIMG: This program is protected by copyright law and
international treaties.

ODBC Driver
for MySQL

3. In case if you already have the specified installation folder on the PC or another Driver
version is installed, you will get a warning. Click Yes to overwrite the old files with the
current installation, but it is recommended to completely uninstall the previous driver
version first, and then install the new one.

4. On the Select Components page you can select whether to install the 64-bit version of the
driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.
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i® Setup - Devart ODBC Driver for MySQL — >
Select Components
Which components should be installed? devart

Select the components you want to install; dear the compaonents you do not want to
install. Clidk Mext when you are ready to continue.

Full installation w
Devart ODBC Driver for MySQL a,6 MB
P Driver for Win32 2, 7MB
i [#] Driver for Wing4 4,0 MB
Help and Manual 9,1 MB

Current selection requires at least 17,4 MB of disk space.

5. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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i% setup - Devart ODBC Driver — >
License Information
Fleaze enter the path to the file containing the activation key received when devart

purchasing the product. If you have no activation key, select Trial Version.

() Trial
(®) Activation Key

u 1w FjNOD SMGAPOSgfMzjuY AEoDpy fgL¥mIX heuy Hadt S8M4F ZgxWheiBjxwr LS

7 15QYwWOUQOeY Tatef2NfkwL gB +HFAVeYghal 3nMhifdvYIriwFFwZNVIRh 2m4s ]
72EIxR 30F{9BLspR & ydbomx YUY mTAZ FHMQVXWPGQN 2UM 1Y 4odf3c3TTj IRAUAG 2d
eminjcTIIN4HEPxigTQRRGZBHKT 1L 3IAR 1/ f¥sIp/PiKknDSIbxVK +avkETuP

5Qw 1IKL 7hTw0dwStsheAtwPzLEaTi30CHY 3 +2MLSII3 =|

Load Activation Key ...

7. If you have the activation key file, click the Load Activation Key button and browse to it.

Activation — O X

= v « Do, * Activation v O Search Activat.. 2

= This PC Mame Date modified Type

. 30 Ohbj E activation 27.03.2020 13:52 KEY File
I Desktoj
|j Docurm

4 Downlo

D Music v < >

1item =
8. Click Next.

9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.
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See also:

¢ |nstallation on macOS

¢ Install Linux DEB package

¢ |nstall Linux RPM package

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

3.1.2 Windows Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCMySQL.exe /SILENT /ActivationKey=ylc7nmgdu2341laszxcvONGurjfhxm90LH
DevartODBCMySQL.exe /VERYSILENT /ActivationkKey=ekhdh765mh09ukr237gfHRtrilwq9
Note: The installation is performed by entering a license key.

DevartODBCMySQL.exe /SILENT /ActivationFile=d:\1lic.key

DevartODBCMySQL.exe /VERYSILENT /ActivationFile=d:\1ic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

3.1.3 macOS

Prerequisites
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ODBC Diriver for MySQL works under control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Driver for MySQL is compatible with iODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for MySQL will be installed,
but it will require manual modification of configuration files of these managers.

Installing ODBC Driver for MySQL
1. Go to Security & Privacy settings in the System Preferences.

2. Enable the App Store and identified developers option in the Allows apps downloaded

from section.
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[ ] 4 G Security & Privacy Q

m FileVault = Firewall  Privacy

A login password has been set for this user Change Password...

Require password 5 minutes B after sleep or screen saver begins
Show a message when the screen is locked

Disable automatic login

Use your Apple Watch to unlock apps and your Mac

Allow apps downloaded from:

) App Store
° App Store and identified developers

o’
Eﬁ Click the lock to prevent further changes. Advanced... ?

Note: If the options in Allow apps downloaded from section are grayed out, click on the

lock icon and enter your administrator password to proceed with the installation.

3. Download the PKG file from the Devart website.

4. Run the downloaded file, press the Allow button to proceed with the installation.
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® O ‘« Install Devart ODBC Driver for MySQL [

Welcome to the Devart ODBC Driver for MySGL Installer

This will install Devart ODBC Driver for MySQL 2.5.1 on your

@ Introduction computer.
Read Me WARNING: This program is protected by copyright law and international
} treaties
License

Registration
Destination Select
Installation Type
Installation

Summary

Continue

5. After reading the license agreement, click Agree.
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w Install Devart ODBC Driver [

To continue installing the software you must agree to the terms of
the software license agreement.

g Click Agree to continue or click Disagree to cancel the installation and
Rei guit the Installer.
o Lic
Re MS
! Read License Disagree Agree
De|

Installation Type
INTRODUCTION

Installation

§ This Devart end-user license agreement ("Agreement”) is a legal

Summary agreement between you (either an individual person or a single legal
entity) and Devart, for the use of the ODBC Driver software application,
demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this
Agreement, the software program(s) and supporting documentation will
be referred to as the "Software”.

LICENSE

Print... Save... Go Back Continue

6. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

7. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.
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@®C

@ Introduction
© Read Me

© License

© Registration

Destination Select
Installation Type
Installation

Summary

‘& Install Devart ODBC Driver s
Registration

License information
Please enter the path to the file containing the activation key
received when purchasing the preduct. If you have no
activation key, select Trial Version.

I Trial
°' Activation Key

d1asbaFDhafkésHdrnfbvwncnve TR4i11+GDVFC465furdxawBMNYCru
bbv3546ifa6a7litkbbhuvDFaHre2965+gvefxixtrd23nmbCVBrut!/
q1f2b7==chhfvritviXcvRfyurkawRThabvyvuTrwo09/65ii TRABMNNYVCrb
b4 56T Kiiguuvbh

Load Activation Key ...

Go Back Continue

8. If you have the activation key file, click the Load Activation Key button and browse to it.
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[ NON | [l Desktop
4 = [0 o1 == | #~ 0 a Q. Search

Favorites

@ AirDrop A

&Y iCloud Drive A . CTHT |
& All My Files test
pé\; Applications

=] Desktop

@ Documents

0 Downloads

Devices
Remote Disc

Shared
server

@ Al
T m——

[

9. To complete the installation click Continue, then Install buttons.
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314

O & Install Devart ODBC Driver fa)
The installation was completed successfully.
Introduction
Read Me
License
Registration
3 0 - -
Destirstion Sekoat The installation was successful.
bl bl The software was installed.
Installation
Summary

To activate the driver, perform the steps described in the Product Activation article.

See also:

¢ |nstallation on Windows

¢ |nstall Linux DEB package

¢ Install Linux RPM package

© 2015-2024
Devart. All Rights Request Support

ODBC Forum
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Linux DEB

Prerequisites

Provide Feedback
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ODBC Diriver for MySQL works under control of an ODBC driver manager. ODBC driver
manager is not distributed along with our driver and must be installed separately.

ODBC Driver for MySQL is compatible with UnixODBC driver manager. You can install the
unixODBC driver manager using the command below:

sudo apt-get install odbcinstldebian2 libodbcl odbcinst unixodbc

In case when using other ODBC driver managers, ODBC Driver for MySQL will be installed,
but it will require manual modification of configuration files of these managers.

Installation

Let's consider how to install the Devart ODBC driver on Linux from a DEB package, for
example, on Ubuntu. There are two ways to install the driver either manually or via the
command line.

GUI installation
1. Download the DEB package of the required bitness from the Devart website.

2. Navigate to the folder with the downloaded package ("Downloads" by default) and double-
click it.

3. In the opened dialog, click the Install button.
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Ubuntu Software

devartodbcmysqgl

devartodbcmysql

Mew level of functionality and performance in data access via ODBC

Install

Devart ODBC Driver for MySQL provides a high-performance and Feature-rich connectivity solution for ODBC-
based applications to access MySQL, Microsoft Azure Database for MySQL, MariaDB, Amazon Aurora
databases from Windows, macOS, Linux, both 32-bit and 64-bit. Full support for standard ODBC API functions
and data types implemented in our driver makes interaction of your database applications with MySQL Fast,
easy and extremely handy.

Website

Details

Version 3.0.1
Source Unknown
Size 4.4 MB

[ non-free Il 3rd party J

This software comes from a 3rd party and may contain non-free components.

4. If the installation is successfully completed, the Install button changes into the Remove

one.

Command-line installation
1. Download the DEB package from the Devart website.

By default the required package will be downloaded into the ~/Downloads folder (or the
selected one);

2. Run the 'Terminal' program;
3. Navigate to the folder with the downloaded package cd ~/Downloads (if you downloaded
the package into another folder, you need to specify the path to this folder as the cd

command parameter):

© 2024 Enter your company name


https://www.devart.com/odbc/mysql/download.html

Using ODBC Driver 33

cd ~/Downloads/

test@ubuntu:~% cd ~/Downloads/
test@ubuntu:~/Downloads$ [

4. To install the devartodbcmysql_i386.deb on a 32-bit system, use the following command:

sudo dpkg -1 devartodbcmysql_1386.deb

test@ubuntu:~% cd ~/Downloadsf
test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcmysql 1386.deb |}

5. To install the devartodbcmysql_amd64.deb on a 64-bit system, use the following

command:

sudo dpkg -i devartodbcmysql_amd64.deb

test@ubuntu:~5% cd ~/Downloads/
test@ubuntu:~/Downloads$ sudo dpkg -i devartodbcmysql _amdé4.deb |}

6. Driver is installed successfully.

test@ubuntu:~/Downloads$ sudo dpkg -1 devartodbemysql 1386.deb
(Reading database ... 238050 files and directories currently installed.)
Preparing to unpack devartodbcmysql i386.deb ...

Unpacking devartodbcmysgl (3.8.1) over (3.6.1) ...
Setting up devarteodbcmysgl (3.0.1) ...
test@ubuntu:~/Downloadss

To activate the driver, perform the steps described in the Product Activation article.

See also:
e |nstall Linux RPM package

¢ |nstallation on Windows
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¢ |nstallation on macOS

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

Linux RPM

Prerequisites
ODBC Diriver for MySQL works under control of an ODBC driver manager. ODBC driver

manager is not distributed along with our driver and must be installed separately.
ODBC Driver for MySQL is compatible with UnixODBC driver manager.

In case when using other ODBC driver managers, ODBC Driver for MySQL will be installed,
but it will require manual modification of configuration files of these managers.

Installation

Let's consider how to install the Devart ODBC driver on Linux from an RPM package, for
example, on CentOS. To install the driver, you should download the .rpm package and install
it via the command line. See the detailed description of these steps below:

1. Download the RPM package from the Devart website.

By default the required package will be downloaded into the ~/Downloads folder (or the
selected one);

2. Run the 'Konsole' program;

3. Navigate to the folder with the downloaded package cd ~/Downloads (if you downloaded
the package into another folder, you need to specify the path to this folder as the cd

command parameter):

cd ~/Downloads/
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4. To install the devart-odbc-mysql.i386.rpm on a 32-bit system, use the following command::

sudo rpm -ivh devart-odbc-mysql.1386.rpm

[test@localhost ~]% sudo rpm -ivh devart-odbc-mysql.i386. rpm

To install the devart-odbc-mysql.x86_64.rpm on a 64-bit system, use the following

command::

sudo rpm -ivh devart-odbc-mysql.x86_64.rpm

.x86_64.rpm |

To activate the driver, perform the steps described in the Product Activation article.

See also:
¢ Install Linux DEB package

¢ |nstallation on Windows

¢ |nstallation on macOS

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.
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3.2 Product Activation

See how to activate Devart ODBC Driver for MySQL :
e Obtaining Activation Key

e Activation on Windows

e Activation on macOS

e Activation on Linux

¢ Where to see the license information

© 2015-2024
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Reserved.

3.21 Obtaining Activation Key

To obtain a product activation key, follow these instructions:
1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.

3. You can copy the Activation Key either from the registration email or at the Customer Portal
account.

4. To login to the Customer Portal, use your Username and Password from the registration
email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:
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Activation Key

ulwTiCODBNGAEDFghMNzjuTAToDjwgLNmX Meuy+kt2YisW39cp39ih89)Z6mCh
MhlQfsILhFIgrh QWX TEmuz 1)i+IQycFEPkmX+Z5Y QP XtTebxgMUSHsUdPNsKis
93Ee03mgHGadwIIHSQXuKKBzPIxDI8 1io5ffSvmpp|LEEXvIaOkPRh4araaudUiK
rodrz GOxukSjdOMNfxzeykQ==

COPY TO CLIPBOARD CLOSE

6. Copy the Activation Key with the Copy to Clipboard button.

See also:

e Activation on Windows

e Activation on macOS

e Activation on Linux

© 2015-2024
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3.2.2 Activation on Windows

Driver Activation After Installation

To activate your installed driver using ODBC Administrator, perform the following steps:
1. Run ODBC Administrator.

i&'

Data Sources
(QDBC)

2. In the System DSN tab click the Add button.
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E ODBC Data Source Administrator (4-bit) >

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QODBC Driver for Azure_x32 32bit Devart ODBC Driverfor SGL S

QODBC Driver for BigCommerce_x32 32-bit Devart QDBC Driver for BigCor Remaove
QDBC Driver for Dynamics_32 32bit Devart QDBC Driver far Dynam

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebir: Configure...

QDBC Driver for Magento_x32 32bit Devart QDBC Driver for Mager
QODBC Driver for MailChimp_x32 32bit Devart QDBC Driver far MailCh
QDBC Driver for MangoDB Gd-bit Devart QDBC Driver far Mongao
QDBC Driver for MangoDB_x32 32bit Devart QDBC Driver far Mongao

QDBC Driver for MySQL 32bit 32hit Devart ODBC Driver for MySQI ¥
£ >

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

B

Cancel Apply Help

3. In the appeared dialog box, select the installed driver, click Finish.
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

39

4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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| General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . 0K Cancel

5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

Input Activation Key

Activation Key:

U 1w FRODEBGAEIFgbMZUTAToG v faLMmIX fheuy HdSpWCSKTE +d 2ZIwrmnI +A4A
u lw FCODENGAEDIFgbNzZiuTg ToD v /gLMmIX heuy Hel 5 IN4ZZgxWh 2MiXwr IS
A7E 103mgH6a 5w 1S fSQXuKKSzPIxDIS 1to 5 5vmppiL3EXvIaOkPRh4araausUf
a9BZh4ERVELA /pR IHWLZSXZ8k00 12Cx FaGy v 1¥hiknLRK 2L sbLMLP&mbxBC 2gn
WEZSMMErH72950xNiFvtZ IFnMsC 7 4scOuigWQsRed s =

Load Key...

Cancel

6. If you have the activation key file, click the Load Key button and browse to it.
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7. Click OK.
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3.2.3 Activation on macOS

Driver Activation After Installation

If you don’t activate your driver during installation, you can activate it later by following the
steps:

1. Create a file with the "activation.key" name.

2. Copy the activation key from the registration email or your Customer Portal account and
paste it into the created file.

3. Place the "activation.key" file into the folder where the driver was installed (for Devart

ODBC Driver for MySQL it is /Library/ODBC/Devart/Mysq| by default).

See also:

e Activation on Windows

e Activation on Linux
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3.2.4 Activation on Linux

Driver Activation After Installation

If you did not activate the driver during installation, you can activate it later:

1. Create a file with the "activation.key" name.

2. Copy the activation key from the registration email or your Customer Portal account and

paste it into the created file.

3. Place the "activation.key" file into the folder where the driver was installed:
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- for the DEB package of Devart ODBC Driver for MySQL, it is /usr/share/devart/odbcmysql
by default;

- for the RPM package of Devart ODBC Driver for MySQL, it is /usr/local/devart/odbcmysql by
default.

See also:

e Activation on Windows

e Activation on macOS

© 2015-2024
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3.2.5 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. In the Control Panel run ODBC Administrator

Data Sources

(ODBC)

2. Open the System DSN tab and click the Add button
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System Data Sources:

E ODBC Data Source Administrator (4-bit)

Mame

QODBC Driver for Azure_x32

QODBC Driver for BigCommerce_x32
QDBC Driver for Dynamics_32
QDBC Driver for Firebird_x32
QDBC Driver for Magento_x32
QODBC Driver for MailChimp_x32
QDBC Driver for MangoDB

QDBC Driver for MangoDB_x32

QDBC Driver for MySQL 32bit
£

Platfarm
32-bit
32-bit
32-bit
32-bit
32-bit
32-bit
G4-bit
32-bit
32-bit

Diriver

Devart QDBC Driverfor SAL 5
Devart QDBC Driver for BigCor
Devart QDBC Driver far Dynam
Devart QDBC Driver for Firebirc
Devart QDBC Driver for Mager
Devart QDBC Driver for MailCh
Devart QDBC Driver far Mongao
Devart QDBC Driver far Mongao

Devart ODBC Driver for MySQI ¥
>

B

Cancel

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

Add...

Remove

Configure...

Apply

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

Help

3. Select the driver and click Finish
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

4. In the appeared dialogue, select the License tab
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General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . Ok Cancel

See also
e Product Activation
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3.3 Connecting to MySQL

See how to connect the Devart ODBC Driver for ODBC Driver for MySQL.:
¢ \Windows DSN Configuration

e macOS DSN Configuration

¢ Linux DSN Configuration

© 2015-2024
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3.341

Windows

Windows DSN Configuration
After installing the driver, create a DSN for MySQL in the ODBC Data Source Administrator.
1. Open the ODBC Data Source Administrator.

e Type opBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWoW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe t0O create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for ODBC Driver for MySQL and click Finish. The driver
setup dialog will open.

5. Enter the connection information in the appropriate fields.
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Devart QDBC Driver for MySQL Configuration by

Data Source Mame |Devart MyS0L |

Description |ODBC Driver |
Server 127.0.0.1 v | Port [3306 |
User ID |r|:n:|t |

Password |-'l"- | [+] 5ave Password
Database |1:est |

Test Connection ver Cancel

6. You may test the connectivity by clicking Test Connection.

7. Click OK to save the DSN.

See Also
Connection Options

© 2015-2024
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3.3.2 Mac

macOS DSN Configuration

After the driver is installed, DSN with the name DEVART_MYSQL is created. You can use it to
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test a connection with MYSQL server. For this, perform the following steps:
1. Run the iODBC utility of the required bitness. Find the DEVART_MYSQL section and click

the Configure button:

] iODBC Data Source Administrator (64-Bit Edition)

User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE - Devart ODBC Driver for ASE

DEVART_FIREBIRD - Devart ODBC Driver for Firebird Remava
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongoDB, ——
DEVART_MYSQL Devart ODBC Driver for MySGQL
DEVART_ORACLE - Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSG Test
DEVART_REDSHIFT - Devart ODBC Driver for Amazen R
DEVART_SQLAZURE - Devart ODBC Driver for SAL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER Devart ODBC Driver for SQL Serve

_ System Data Source Mames create systems-wide CDBC Data Names that resolve to Data
: E Source connection information.

Cancel
-

2. In the appeared dialog, specify the required connection settings and click OK.
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@O Setup of DEVART_MYSQL
Data Source Name (DSN) | DEVART_MYSQL
Comment

Keyword Value
User ID root
Password ErEEEE
Data Source localhost
Database test

Port 3306

+ -

3. Now click the Test button to establish a test connection to your data source.

49
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@ iODBC Data Source Administrator (64-Bit Edition)

User DSN File DSN ODBC Drivers Connection Pooling Tracing About

System Data Sources

Name Description Driver Add
DEVART_ASE - Devart ODBC Driver for ASE

DEVART_FIREBIRD - Devart ODBC Driver for Firebird Remova
DEVART_INTERBASE - Devart ODBC Driver for InterBase Configure
DEVART_MONGODB - Devart ODBC Driver for MongeDB, ———
DEVART_MYSQL Devart ODBC Driver for MySQL
DEVART_ORACLE - Devart ODBC Driver for Oracle
DEVART_POSTGRESQL - Devart ODBC Driver for PostgreSC Test
DEVART_REDSHIFT - Devart ODBC Driver for Amazon R
DEVART_SQLAZURE - Devart ODBC Driver for SQL Azure
DEVART_SQLITE - Devart ODBC Driver for SQLite

DEVART SQLSERVER Devart ODBC Driver for SOL Serve

System Data Source Names create systems-wide ODBC Data Mames that resolve to Data
Source connection information.

See Also
Connection Options

© 2015-2024
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3.3.3 Linux

Linux DSN Configuration

After the linux (DEB or RPM) driver is installed, a DSN with the name DEVART_MYSAQL is
created. You can use it to test the connection with the MYSQL server. For this, perform the

following steps:
1. Open the odbc.ini file located in the /etc folder. Find the DEVART_MYSQL section and

specify the required connection settings:
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User ID=<your MySQL User Name>
Password=<your MySQL password>
Server=<your MySQL server address>
Port=<your MySQL Port>
Database=<your MySQL database name>

2. Run the UnixODBC Test Command utility and test a connection using the following

command:

isql -v DEVART_MYSQL

test@ubuntu:~S$ isql -v DEVART_MYSQL

sql-statement
help [tablename]
quit

+
| Connected!
|
|
|
|
|

See Also
Connection Options
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3.4 Connection String Parameters

MySQL ODBC Connection String Parameters

The following table lists the connection string parameters for MySQL.
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Paramet

er
Server

Port
User ID
Password

Database

Charset

UseUnicode

Compress

Interactive

Advanced

Allow NULL

strings

Description

Serves to supply the server name for login.

Used to specify the port number for the connection. 3306 by default.

Used to supply a user name for login.

Used to supply a password for login.

Used to set the name of the database

Used to set the character set that ODBC driver for MySQL uses to read
and write character data.

Informs server that all data between client and server sides will be passed
in Utf8 coding. Setting this option converts all fields of the String type into
WideString that allows to work correctly with symbols of almost alll
languages simultaneously. On the other hand, it causes a delay in working.
If the Use Unicode property is enabled, the Charset property will be
ignored. The default value is False.

Used to apply compression on transferring data. Setting this property to
True is quite effective on transferring big volumes of data through slow
connection. Pay attention that each row is compressed separately. Be
careful when setting this option as in some cases it may decrease fetch
speed instead of increasing. The default value is False.

Permit interactive_timeout seconds (instead of wait_timeout seconds) of
inactivity before closing the connection. The client's session wait_timeout
variable is set to the value of the session interactive_timeout variable. The

default value is false.
Settings

To retrieve metadata, not all parameters according to MSDN can accept a
null value. If NULL, the driver should return an error. But some 3rd-party

tools pass NULL to the parameters. These options should be enabled for
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Empty

strings as  |compatibility with such tools.

NULL

Connection The time (in seconds) to wait for a connection to open before terminating
Timeout an attempt. The default value is 15.

The Internet Protocol Version.
ivIPv4

The default value. Internet Protocol Version 4 (IPv4) is used.
ivIPv6
Internet Protocol Version 6 (IPv6) is used.

IP Version |ivIPBoth
Either Internet Protocol Version 6 (IPv6) or Version 4 (IPv4) is used.
Note: When the property is set to ivIPBoth, a connection attempt is made
via IPv6 ifitis enabled in the operating system. If the connection attempt
fails, a new connection attempt is made via IPv4.
Used to set the behavior corresponding to the ODBC specification
version that a third-party tool expects. The behavior of ODBC driver can
be changed by setting a value for the SQL_ATTR_ODBC_VERSION
attribute by calling the SQLSetEnvAttr function. But some third-party tools
expect the driver to exhibit ODBC 2.x behavior, but forget to call

ODBC SQLSetEnvAttr with the specified version or pass an incorrect value there.

Behavior In this case, the required behavior can be explicitly specified in the

Connection String by setting the ODBC Behavior parameter. The possible

values are:

* Default - default ODBC behavior determined by a third-party tool.
* Ver 2.x- ODBC 2.x behavior is explicitly set.
* Ver 3.x- ODBC 3.x behavior is explicitly set.

Query Used to specify the number of seconds that the execution of an SQL query

Timeout can take before itis terminated and an exception is raised. If the value is
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0, no timeout will happen. The default value is 0.
RegionalNu

Enables the use of local regional settings when converting numbers to
mberSetting|

strings.
S

RegionalDat ) ) .
Enables the use of local regional settings when converting dates and

eTimeSettin| )
times to strings.
gs

Sets the string value types returned by the driver as Default, Ansi or

Unicode.
® Default - the driver defines the string types.
* Ansi - all string types will be returned as SQL_CHAR, SQL_VARCHAR
String Types, and SQL_LONGVARCHAR.
® Unicode - all string types will be returned as SQL_WCHAR,
SQL_WVARCHAR and SQL_WLONGVARCHAR.

The parameter value should be changed if any third-party tool supports

only Ansi string types or Unicode ones.

¥apF’Si’t‘9 Used to convert TIMESTAMP values to VARCHAR values. The default
Imestamp value is False.
as VarChar

MySQL ODBC Connection String sample

DRIVER={Devart ODBC Driver for MySQL};User
ID=root;Password=root;Data Source=localhost;Database=test

See also:
e SSL Connection

e SSH Connection

e HTTP Tunneling

© 2015-2024
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Reserved.
3.5 Secure Connections
This section describes how to establish secure connections to MySQL with ODBC Driver for

MySQL.

e SSL Connection

e SSH Connection

e HTTP Tunneling

© 2015-2024
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3.51 SSL Connection

Connecting to MySQL Using SSL

SSL (Secure Sockets Layer) is a standard protocol for secure access to a remote machine
over untrusted networks. It runs on top of TCP/IP to secure client-server communications by
allowing an SSL-enabled client to authenticate itself to an SSL-enabled server and vice versa.
During server authentication, an SSL-enabled client application uses standard techniques of
public-key cryptography to verify the server's identity by checking that the server's certificate
is issued by a trusted certificate authority (CA) and proves the ownership of the public key.

Conversely, SSL client authentication allows the server to validate the client's identity. The
client and server can also authenticate each other using self-signed certificates, however, you
will almost never want to use a self-signed certificate, except for an Intranet or a development
server. After establishing an SSL connection, the client and server can exchange messages
that are symmetrically encrypted with the shared secret key. SSL is the recommended
method to establish a secure connection to MySQL due to easier configuration and higher
performance, compared to SSH. See the MySQL documentation for more information on how
to configure MySQL to use encrypted connections and create SSL certificates and keys .

To establish an SSL connection to MySQL, specify the SSL certificates and client private key:
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Devart ODBC Driver for MySQL Configuration et
General Advanced settings Secure settings  [jcense  About
550 Options 554 Options  HTTP and HTTPS Options
Use 55L
CA Certificate |C: \cacert.pem |
Certificate |C: \dient-cert.pem |
Key |C: \dient-key.pem |
[ ]ignore Server Certificate Validity
|:| Ignore Server Certificate Constraints
[]Trust server Certificate
|:| Ignore Server Certificate Insecurity
Test Connection Cancel
SSL Options
Option Description
Use SSL Enables SSL connections.
SSL CA Cert The CA certificate.
SSL Cert The client certificate.
SSL Key The private client key.

Ignore Server Certificate Validity

Specifies whether to check the server
certificate validity period during an SSL

handshake. The default value is True.

Ignore Server Certificate Constraints Specifies whether to verify the server
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3.5.2

certificate for compliance with constraints
during an SSL handshake. The default

value is True.

Specifies whether to verify the server
certificate during an SSL handshake. By
default, the driver verifies the server

Trust Server Certificate ) o
certificate. When the option is set to True,

the driver will bypass walking the certificate

chain to verify the certificate.

Specifes whether to check the server
Ignore Server Certificate Insecurity |certificate signature security during an SSL

handshake. The default value is False.

Sample SSL Connection String

DRIVER={Devart ODBC Driver for MySQL};User
ID=myUser;Password=myPassword;Data
Source=myServer;Database=myDatabase;Port=myPort;SSL=True;SSL CA
Cert=C:\myCacCertificate.pem;SSL Cert=C:
\myCTlientCertificate.pem;Key=C:\myPrivateClientKey.pem

© 2015-2024
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SSH Connection

Connecting to MySQL Using SSH

This section discusses how to connect to MySQL through SSH. Secure Shell (SSH) is
cryptographic network protocol for secure remote login, command execution and file transfer
over untrusted networks. SSH uses client-server architecture, connecting an SSH client with
an SSH server. The client and server authenticate each other and pass commands and
output back and forth. To secure the transmitted data, SSH employs forms of symmetric
encryption, assymetric encryption, and hashing.
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In symmetric key cryptography, a single key is used by the sending and receiving parties to
encrypt and decrypt messages. Assymetric encryption requires two associated keys, the
private key and the public key. The public key encrypts messages that can only be decrypted
by the private key. The public can key can be freely shared with anyone to autenticate another
party, while the private key must be kept secret. The client public key must be stored in a
location that is accessible by the SSH server to authenticate the server by the client;
conversely, the server public key must be placed on the client side to authenticate the client
by the server. Assymetrical encryption is used during the initial key exchange process to
produce the shared secret (session key) to encrypt messages for the duration of the session.

The SSH server listens on default port 22 (this port can be changed) for incoming TCP
connections. The SSH client begins the initial TCP handshake with the server and verifies the
server's identity. The client and server agree upon the encryption protocol and negotiate a
session key. The server then authenticates the client and spawns the right environment. The
ODBC driver for MySQL implements the SSH client feature to connect to the SSH server on

the remote machine at the specified port. The SSH server authenticates the client and
enables the driver to establish a secure direct connection to MySQL. Below is a simplified
diagram representing the SSH tunneling.

Devart ODBC Untrusted

: DB Server
Driver Network SSH Server

-
v
B
v
r 9
v

Note: You don't have to install the SSH client since ODBC Driver for MySQL implements the
SSH client functionality.

SSH Connection Options

To establish an SSH connection to MySQL, specify the connection parameters on the ssH

Ooptions tab under security Settings.
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Devart ODBC Driver for MySQL Configuration et
General Advanced settings 5
S5L Options  55H Options  HTTP and HTTPS Options
Use 55H
Host name |192.168.50. 160
Port |22 |
User name |LlserSSH |
Password | Ty |
Client private key |PrivateKEy.pem |
Password for key | EEEREEE |
Server public key |F'LI|:l|iEKEF-|:lEI‘ﬂ |
Storage path |D: Keysh |
Test Connection - Cancel
SSH Connection Options:
Option Description
Use SSH Enables SSH connections.

SSH Host name

SSH Port

SSH User Name

SSH Password

The host name or IP address of the SSH

server.

The SSH port number (22 by default).

The username for the account on the SSH
server.

The password for the account on the SSH

server.
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The filename of the client private key for
SSH Client Key o
key-based authentication.
SSH Client Key Password The passphrase for the client private key.
SSH Server Key The filename of the SSH server public key.
The directory where the encryption keys are
SSH Storage Path
stored.
Sample Connection String:
DRIVER=Devart ODBC Driver for MySQL;User
ID=myUsername;Password=myPassword;Data
Source=myHost;Database=myDatabase;Port=myPort;Use SSH=True;SSH
Host name=mySshHost;SSH User Name=mySshuUsername;SSH
Password=mySshPassword;SSH Client Key=myPrivateClientKey.pem;SSH
Client Key Password=myClientKeyPassphrase;SSH Server
Key=myPublicServerKey.pem;SSH Storage Path=myDirectorywithKeys
© 2015-2024
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3.53 HTTP Tunneling

Connecting to MySQL Using HTTP Tunneling

This section discusses how to connect the ODBC driver to MySQL through an HTTP tunnel.
If you need to connect to MySQL in conditions of restricted connectivity, e.g. when a database
server is hidden behind a firewall, or you need to transmit private network data through a
public network, you can set up an HTTP tunnel to create a direct network link between two
locations. The tunnel is created by an intermediary called a proxy server.

When MySQL server is hidden behind a firewall, the client is not able to connect to the server
directly on a specified port. If the firewall allows HTTP connections, you can use the ODBC
driver with a properly configured web server to connect to the database server. The driver
supports HTTP tunneling based on the PHP script.

A possible scenario of using HTTP tunneling: the client needs to access the database of a
website from a remote machine, but access to the designated port of the database server is
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forbidden — only connections on the HTTP port 80 are allowed. To establish a connection in
this situation, you must deploy the tunnel.php script, which is distributed with the driver, on
the web server. It enables access to the database server through an HTTP tunnel. The script
must be accessible through HTTP. You can verify the script accessibility using any web
browser. The script file is located in the "C:\Program Files (x86)\Devart\ODBC\MySQL\http
\tunnel.php" folder. The web server must support PHP 5 or later.

To set up an HTTP tunnel, specify the connection parameters on the HTTP and HTTPS Options
tab under security Settings.

Devart QDBC Driver for My50L Configuration et
General Advanced settings Secure setlings  License About
55l Options  S5H Options  HTTP @nd HTTPS Options

IUse HTTP or HTTPS

Url |htn:|:,|’fseruerft_|nnel.php

Uszer name |th:|LIser |

Password |iiiiliiiiill |
Proxy Options
Host name |
Port 0 |
ser name | |
Password | |

I Test Connection | 0K Cancel

HTTP Tunneling Options

Option Description

Use Http |Enables HTTP tunneling.

Http Url | The URL of the PHP script for HTTP tunneling.

Http User |The username for the password-protected directory that contains the
Name HTTP tunneling script.
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Http The password for the password-protected directory that contains the
Password  |HTTP tunneling script.

Http Trust SPecifies whether to verify the server certificate during an SSL

Server handshake. When True, the driver bypasses walking the certificate chain

Certificateto verify the certificate. The default value is False.

Sample Connection String Using HTTP Tunneling

DRIVER=Devart ODBC Driver for MySQL;User
ID=myUsername;Password=myPassword;Data
Source=myHost;Database=myDatabase;Port=myPort;Use
Http=True;Url=https://host/folder/tunnel.php;Http User
Name=myHttpUsername;Http Password=myHttpPassword

Connecting Through HTTP Tunnel and Proxy Server

The HTTP tunneling server may be not be directly accessible from the client machine. In this
case, you need to additionally provide connection information for the proxy server.
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Devart ODBC Driver for My50L Configuration X
General Advanced settings  Secure settings  License About
55L Options  55H Options  HTTP and HTTPS Options
[] Use HTTP or HTTPS
Url |hth:|:,|",|"server,|"b_|nnel.php
User name |H1:n:ul_lser |
PESS'J‘-.'I:IFIj |""-"."-' |
Proxy Options
Host name |1III.III.IZI.1
Part |3128 |
User name |F‘r|:|xyLlser |
PESS'.I".'Drd |------------- |
I Test Connection | Ok Cancel
Proxy Options
Option Description
Proxy Host Name The proxy hostname or IP address.
Proxy Port The proxy port.

Proxy User Name

Proxy Password

The proxy username.

The proxy password.

Sample Connection String Using HTTP Tunneling and Proxy Server

DRIVER=Devart

ID=myUsername;
Source=myHost;

ODBC Driver for MySQL;User
Password=myPassword;Data
Database=myDatabase;Port=myPort;uUse

Http=True;Url=https://host/folder/tunnel.php;Http User
Name=myHttpUsername;Http Password=myHttpPassword;Proxy Host
Name=myProxyHost;Proxy Port=myProxyPort;Proxy User
Name=myProxyUsername;Proxy Password=myProxyPassword
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Additional Information
There is one more way to tunnel network traffic. The Secure Shell forwarding, or SSH, can be
used for data forwarding. However, SSH is designed to encrypt traffic rather than traverse
firewalls. The Connecting via SSH document describes how to set up an SSH connection in
the ODBC Driver for MySQL.
Note that traffic tunneling or encryption increases the CPU and bandwidth usage. It is
recommended that you use direct connection whenever possible.
© 2015-2024
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3.6 Sandboxed Apps on macOS

Sandboxed Apps on macOS

Sandboxed applications don’t have permission to access iODBC Driver Manager on macOS.
This is caused by the System Integrity Protection (SIP) technology on macOS which protects
your files and folders from potentially malicious software by locking the application. When
accessing a data source from an application like Excel through the ODBC driver for MySQL,

you may get an error message saying that the driver is unable to create a file.

Note that all third-party applications distributed through the Mac App Store are sandboxed.

Disabling System Integration Protection (SIP) on macOS

To resolve the issue, you should turn off SIP on your computer:

1. Restart your computer in Recovery mode (hold down Command + R until you see the
Apple logo).

2. Select Utilities > Terminal.

3. In the Terminal window, enter csrutil disable.

[ ] ] Terminal — -bash — 80x 24

-bash-3.2# csrutil disable

Successfully disabled System Integrity Protection. Please restart the machine fo
r the changes to take effect.

-hash-3.2# rebootf]
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4. Restart your computer.

5. Enter csrutil status to check the status of SIP.

& & 3y test — paserver — -bash — BOx24

tests—imac-2:~ testd csrutil status
System Integrity Protection status: disabled.
tests—imac-2:~ tests I

Enable SIP after you finish working with an ODBC data source. To turn on SIP, enter csrutil

enable and restart your computer.
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3.7 Using with iODBC

Using the Driver with iODBC

Among known issues with iODBC driver manager is incorrect handling of the following ODBC
data types:

e« SQL_WCHAR
 SQL_WVARCHAR
 SQL_WLONGVARCHAR

For this reason, we recommend using the following data types instead:
e SQL_CHAR

* SQL_VARCHAR
¢ SQL_LONGVARCHAR

If you have to work with the SQL_WCHAR, SQL_WVARCHAR, and SQL_WLONGVARCHAR
data types, we recommend that you use the unixODBC driver manager rather than iODBC.
© 2015-2024
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3.8

Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-Wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the

application, then click app1y.
. Click start Tracing Now.
. Restart all application processes.
. Click Test connection in the DSN settings to make sure the driver is able to connect.
. Reproduce the issue.

. Click stop Tracing Now on the Tracing tab.

© 0o N O O

. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.
3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.
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Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the

[opBC] section of the /etc/odbcinst. ini file, for example:

[ODBC]
Trace=Yes

TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.
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3.9 Supported Data Types

Data Type Mapping

The Devart ODBC Driver for MySQL supports all MySQL data types.

The following table describes how the MySQL data types are mapped to the ODBC data

types.

MySQL Data Types
DECIMAL, NEWDECIMAL

BIT

TINY
SHORT
INT24

LONG
LONGLONG
FLOAT
DOUBLE
TIMESTAMP
DATE, NEWDATE
TIME

ODBC Data Types
SQL_DECIMAL

SQL_INTEGER
SQL_TINYINT
SQL_SMALLINT
SQL_INTEGER
SQL_INTEGER
SQL_BIGINT
SQL_REAL
SQL_DOUBLE
SQL_TYPE_TIMESTAMP
SQL_TYPE_DATE
sQL_TYPE_TIME
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3.10

DATETIME
YEAR

VAR_STRING, VARCHAR

SQL_TYPE_TIMESTAMP
SQL_SMALLINT

ifis flagged as binary - SQL_VARBINARY
else - SQL_VARCHAR

ifis flagged as binary - SQL_BINARY

STRING
else - SQL_CHAR
NULL SQL_VARCHAR
ENUM SQL_CHAR
SET SQL_CHAR
TINY_BLOB
ifis flagged as binary -
MEDIUM_BLOB 99 i
SQL_LONGVARBINARY
LONG_BLOB
- else - SQL_LONGVARCHAR;
BLOB
© 2015-2024
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Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out

whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for MySQL supports all deprecated functions for backward compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support

SQLAllocHandle

Standard Purpose

Obtains an
ISO 92 _
environment,
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SQLConnect v ISO 92
SQLDriverConnect v ODBC
SQLAllocEnv ' Deprecated
SQLAllocConnect ' Deprecated

connection,
statement, or
descriptor handle.
Connects to a
specific driver by
data source name,
user ID, and
password.
Connects to a
specific driver by
connection string or
requests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
environment handle
allocated from driver.
Obtains a

connection handle

ODBC API Calls for Obtaining Information about a Driver

and Data Source

Function Name Support Standard

SQLDataSources v ISO 92

Purpose
Returns the list of

available data
sources, handled by

the Driver Manager
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SQLDrivers

SQLGetInfo

SQLGetFunctions

SQLGetTypelnfo

ODBC

ISO 92

ISO 92

ISO 92

Returns the list of
installed drivers and
their attributes,
handles by Driver
Manager

Returns information
about a specific
driver and data
source.

Returns the functions
supported by the
driver.

Returns information
about supported
data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes

Function Name

SQLSetConnectAttr

SQLGetConnectAttr

SQLSetConnectOpti

on

SQLGetConnectOpti

on

SQLSetEnvAttr

Support

Standard
ISO 92

ISO 92

Deprecated

Deprecated

ISO 92

Purpose
Sets a connection

attribute.

Returns the value of
a connection
attribute.

Sets a connection
option

Returns the value of

a connection option

Sets an environment
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SQLGetEnvALttr

SQLSetStmtAttr

SQLGetStmtAttr

SQLSetStmtOption

SQLGetStmtOption

ISO 92

ISO 92

ISO 92

Deprecated

Deprecated

attribute.

Returns the value of
an environment
attribute.

Sets a statement
attribute.

Returns the value of
a statement attribute.
Sets a statement
option

Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name

SQLAllocStmt

SQLPrepare

SQLBindParameter

SQLGetCursorNam

e

SQLSetCursorNam

e

Standard

Deprecated

ISO 92

ODBC

ISO 92

ISO 92

Purpose
Allocates a

statement handle
Prepares an SQL
statement for later
execution.
Assigns storage for
a parameterinan
SQL statement.
Returns the cursor
name associated
with a statement
handle.

Specifies a cursor

name.
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) Sets options that
SQLSetScrollOption
v, ODBC control cursor
s
behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose

Executes a prepared
SQLExecute v ISO 92
statement.

) Executes a
SQLExecDirect v ISO 92
statement
Returns the text of an
) SQL statement as
SQLNativeSq| v ODBC
translated by the
driver.
Returns the
] description for a
SQLDescribeParam v ODBC
specific parameter
in a statement.
Returns the number
SQLNumParams v ISO 92 of parameters ina
statement.
Used in conjunction
with SQLPutData to
supply parameter
SQLParamData v ISO 92 PPYP
data at execution
time. (Useful for long

data values.)

Sends partor all ofa
SQLPutData \/ ISO 92
data value for a
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parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

Function Name Support Standard Purpose
Returns the number

of rows affected by

SQLRowCount v ISO 92
aninsert, update, or
delete request.
Returns the number
SQLNumResultCols .\/ ISO 92 of columns in the
result set.
] Describes a column
SQLDescribeCol v ISO 92
in the result set.
Describes attributes
SQLColAttribute .\/ ISO 92 of a column in the
result set.
Describes attributes
SQLColAttributes v Deprecated of a columniin the
result set.
Returns multiple
SQLFetch v, ISO 92
result rows.
Returns scrollable
SQLFetchScroll v ISO 92
result rows.
Returns scrollable
SQLExtendedFetch v Deprecated
result rows.
Positions a cursor
SQLSetPos v ODBC

within a fetched
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block of data and
enables an
application to refresh
data in the rowset or
to update or delete
data in the result set.
Performs bulk
insertions and bulk
SQLBukOperations y ODBC bookmark
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic
Information

Function Name Support Standard Purpose
Returns additional

SQLError v Deprecated error or status
information

Returns additional
diagnostic
information (a single
field of the

diagnostic data

SQLGetDiagField v ISO 92

structure).

Returns additional

diagnostic
SQLGetDiagRec v ISO 92

information (multiple

fields of the
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diagnostic data

structure).

ODBC API Calls for Obtaining Information About
Database Objects (Catalog Functions)

Function Name Support Standard Purpose
Returns a list of

o columns and
SQLColumnPrivileg

es

v, ODBC associated
privileges for one or
more tables.
Returns the list of

SQLColumns v X/Open column names in
specified tables.
Returns a list of
column names that

SQLForeignKeys v ODBC make up foreign
keys, if they exist for
a specified table.
Returns the list of

SQLPrimaryKeys v ODBC column names tha
make up the primary

key for a table.

Returns the list of
input and output
SQLProcedureColu parameters, as well
' OoDBC
mns as the columns that
constitute the result

set for the specified
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procedures.

Returns the list of
SQLProcedures v OoDBC procedure names
stored in a specific
data source.
Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
SQLSpecialColumn table, or the columns
,/ X/Open
S that are
automatically
updated when any
value in the row is
updated by a
transaction.
Returns statistics
about a single table
SQL Statistics ' ISO 92 and the list of
indexes associated
with the table.
Returns a list of
tables and the
SQLTablePrivileges v ODBC privileges
associated with

each table.

Returns the list of
SQLTables v X/Open
table names stored

© 2024 Enter your company name



Using ODBC Driver 77

in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose

Commits or rolls
SQL Transact V' Deprecated .
back a transaction

Commits or rolls
SQLENndTran v ISO 92
back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose
Ends statement

processing, discards
pending results, and,
SQLFreeStmt v ISO 92 optionally, frees alll
resources
associated with the

statement handle.

Closes a cursor that

SQLCloseCursor ' ISO 92 has been opened on
a statement handle.
Cancels an SQL
SQLCancel W, ISO 92
statement.

ODBC API Calls for Terminating a Connection

Function Name Support Standard Purpose
. Closes the
SQLDisconnect v, ISO 92
connection.
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SQLFreeHandle v
SQLFreeConnect v,
SQLFreeEnv v,
© 2015-2024
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Releases an
environment,
connection,
statement, or
descriptor handle.
Releases connection
handle.

Releases an

environment handle.

Provide Feedback

This section discusses how to use ODBC Driver for MySQL with ODBC-compliant tools.

e DBeaver

Oracle Database Link

Microsoft Access

Microsoft Excel

¢ OpenOffice and LibreOffice

* PHP
e Power Bl

* Python

e QlikView

e SQL Server Management Studio

e SSIS

e Tableau

© 2015-2024 Request Support
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4.1

Devart. All Rights
Reserved.

Using in DBeaver

DBeaver Overview

DBeaver is a free, open source multiplatform database management tool and SQL client for
developers and database administrators. DBeaver can be used to access any database or
cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,
Salesforce, or Mailchimp. Devart DBeaver provides you with the most important features
you'd need when working with a database in a GUI tool, such as:

e SQL queries execution

¢ Metadata browsing and editing
e SQL scripts management

e Data export/import

e Data backup

e DDL generation

¢ ER diagrams rendering

e Test data generation

e BLOB/CLOB support

¢ Database objects browsing

e Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports
NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,
SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though
that you can access a MongoDB database from DBeaver Community Edition using the
respective Devart ODBC driver. For the purposes of this guide, we'll use the Community
Edition of DBeaver to retrieve data from MySQL via the Open Database Connectivity driver.

Creating an ODBC Data Source to Use MySQL Data in
DBeaver
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1. Click the Start menu and select Control Panel.
2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system

or select User DSN to configure DSN only for your account.
4. Click the Add button and double-click Devart ODBC Driver for MySQL in the list.
5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for MySQL with DBeaver, SQL_WVARCHAR data types may be
displayed incorrectly in DBeaver. To prevent this, you need to set the string data types to Ansi
either in the Advanced Settings tab of the driver configuration dialog or directly in the
connection string (String Types=Ansi) — all string types will be returned as SQL_CHAR,
SQL_VARCHAR and SQL_LONGVARCHAR. Below you will see guidelines on how to
connect MySQL database in DBeaver.
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License  About

E

Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LONG

[ ]Dates and times

Devart ODBC Driver Configuration
Gereral Advanced settings
Meta Data
Connection
-
Compatibility
ODBC Behavior Default
Siring Types
Use Local Regional Settings when converting to string
[ ] Mumbers
Test Connection

Cancel

Connecting to MySQL Data from DBeaver via ODBC

Driver for MySQL

Follow the steps below to establish a connection to MySQL in DBeaver.

1. In the Database menu, select New Database Connection.

81
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Yy DBeaver 6.1.5

Eile Edit Mavigate Search SOL Editor | Database Window Help

¢ | 9 | 7 I3 i 4 + % NewDatabase Connection
L]

_ ) =% Driver Manager
f® Database Mavigator i3 | [F Projects

¥ Connect

Invalidate/Reconnect
Enter a part of table name here

QODEC - xBase_xbd

Change Connection(s) Driver
ODBC - ZohoCRM_x64

&, ODBC - MailChimp_x64 Pisconned

£ ODBC - MongoDB_x64 Disconnect All

= ODBC - Oracle x64 20 compare/Migrate >
= ODBC - salesforceMC_x64 3 Tools ,
= ODEC - SugarCRM_x64 Context tools Al

2. In the Connect to database wizard, select ODBC and click Next.

fw Connect to database O >

(1

Select your database
ODBC bridge driver

Type part of database/driver name to filter & Gallery

Mame # ~
= ODBC 7
& Apache Ignite
5 AwWS
A Azure

3. Enter the previously configured DSN in the Database/Schema field.
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Generic JDBC Connection Settings
, _ =O0DBC
ODBC connection settings

General Driver properties S5H Proxy

JDBC URL: ‘ jdbciodboDBEAVER_DATASOURCE

Database/Schema: | DBEAVER_DATASOURCE |

User name: ‘ |

Passward: ‘ | Save password locally

4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing MySQL Database Objects and Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all

the tables in MySQL database. To view and edit the data in a table, you need to right-click on
the target table name and select View data.The content of the table will be displayed in the

main workspace.

¥ DBeaver 6.1.5 - emp
File Edit Mavigate Search 30l Editor Database Window Help
&~ | 9 2|05 30 commit [Lrolback T+  Auo |9 v £ 0DBC - MysaL x64 ~

f® Databa.. % |[@Projecs = O Bemp 2

- _ =t N -
¢ -0 = £ Properties | [} Data | 55 ER Diagram 5 ODBC - MyS(
Enter a part of table name here
. E |R’| Eptor SO evoression to filter resulis se (Cirl+Space
ER detail A~ BMP | ww CAET O oL/ EXPIESSON 1O FULEN FESUILLS (LSE LIFITaD0Ce
B8 detail2 o ZSEMPNO 5| fecENAME T1[mocjop T1123mer T G Hi
B detail_with_constraints G
o g - - ﬁ 1 SMITH CLERK 7,902 1980
os
v 2 7499 ALLEM SALESMAM 7,698 19381
em —_—
=) . g 3 7,021 WARD SALESMAM 7,698 1981
Columns zZ
B3 Unique Keys o4 7,566 JOMES MAMAGER 7,839 1931
= Foreign Keys N 5 7,604 MARTIN SALESMAM 7,698 1981
B Indexes b 7,698 BLAKE MAMAGER 7,833 19381
B8 References 7 7,782 CLARK MANAGER 7,839 1981
BB emp tranaction safe 8 7,788 SCOTT ANALYST 7,566 1957-

If you want to write a custom SQL query that will include only the necessary columns from the
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table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.

= Databa.. 2 Projects = B | [T *<0ODBC - MySQL_x64> Script-5 52
ﬁ_ - | - 7 ’ SELECT JOB, EMAME, HIREDATE FROM mydac‘test,emp;
Enter a part of table name here b,
B detail ] i
B detailz p—
FR detail_with_constraints E emp =
B dos +T SELECT JOB, ENAME, HIREL | 2
W
= emsolumns g REC JOB 3| recenaME TF| D HiReDATE T3
Unique Ke}rs ﬁ 1 | SMITH 1a80-12-17 00:00:00
B Foreign Keys Z SALESMAMN ALLEM 1981-02-20 00:00:00
M Indexes = 3_ SALESMAN WARD 1931-02-22 00:00:00
W References '[; 4 | MANAGER JONES 1951-04-02 00:00:00
=2] emp_tranaction_safe " 5_ SALESMAM MARTIMN 1981-09-28 00:00:00
BB empty_master 6 | MANAGER BLAKE 1981-05-01 00:00:00
BB encrypt_types 7 | MANAGER CLARK 1981-06-09 00:00:00
FB fetchalltest 8 | ANALYST SCOTT 1987-07-13 00:00:00
BB films v 9 | PRESIDENT KING 1981-11-17 00:00:00
© 2015-2024
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4.2 Usingin Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
standalone.
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Configure the Initialization File
After installing the gateway and the ODBC driver for MySQL, create an initialization file for

your Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initMysQL.ora. You need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_Fps_conNecT_1INFo parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=MySQL

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orAcLE_HoME \NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = Tocalhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_Name) must be the same in listener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=

(SID_NAME=MySQL)

(ORACLE_HOME=D: \ORACLE_HOME)

(PROGRAM=dg4odbc)

)
)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The sip must match the value specified in the
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4.3

listener.ora file.

MySQL =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = localhost) (PORT = 1521))
(CONNECT_DATA =
(SID = MySQL)

)
(HS = 0OK)

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like
SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also

Configuring Oracle Database Gateway for ODBC
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Using in Microsoft Access

Connecting Microsoft Access to MySQL Using an ODBC
Driver

This article explains how to connect Microsoft Access to MySQL through the standard ODBC
interface. Microsoft Access is a dababase management system that combines the relational
database engine with a graphical user interface. Access can be used as a substitution for
spreadsheet applications like Excel to organize, store, and retrieve large amounts of related
data that can be difficult to manage in spreadsheets.
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In Microsoft Access, you can connect to your MySQL data either by importing it or creating a
table that links to the data. Devart ODBC drivers support all modern versions of Access. It is
assumed that you have already installed and configured a DSN for ODBC driver for MySQL.
For the purpose of this article, we tested an ODBC connection to MySQL through our ODBC

drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft
Access 2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe
how to use Microsoft Access 2019 to import or link to your data in MySQL.

Importing MySQL Data Into Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.
. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for MySQL and click OK.

. In the Import Objects dialog box, select the tables that you want to import, and click OK.

0 N O O

. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps
checkbox. Click Close.

9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to MySQL Data in Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
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9.

ODBC Dababase.

. In the Get External Data - ODBC Database dialog box, select Link to the data source

by creating a linked table.

. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for MySQL and click OK.

. In the Link Tables dialog box, select the table or tables that you want to link to, and click

OK.

. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields

that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the MySQL table as the unique record identifier. You are linking
multiple tables, you will be prompted to select unique record identifiers for each of the

selected tables.

The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.
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Using in Microsoft Excel

Connecting to MySQL from Microsoft Excel using ODBC
Driver for MySQL

You can use Microsoft Excel to access data from a MySQL database using ODBC

connector. With ODBC Driver, you can import the data directly into an Excel Spreadsheet
and present it as a table. Make sure that you use matching Excel and ODBC Diriver, e.g. if
you have installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers. Please see the list of sections that will help you to
connect Excel to MySQL database:

e Connecting Excel to MySQL with Get & Transform (Power Query)

e Connecting Excel to MySQL with Data Connection Wizard (Legacy Wizard)
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e Connecting Excel to MySQL with the Query Wizard

e Connecting Excel to MySQL with Microsoft Query

e Connecting Excel to MySQL with PowerPivot

Connecting Excel to MySQL with Get & Transform
(Power Query)

You can use Get & Transform (Power Query) to connect to MySQL from Excel with ODBC.
This method assumes that you've installed an ODBC driver for MySQL.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other

Sources > From ODBC.

H Book] - Excel Evgeniy Lemeshov [ O
File Home Insert Page Layout Formulas Review View Help @ Tellme S Share
(B [ r B a [Z]A v B B g 6}
JEIEEED 2R EAE
=] [ - .
Get Refresh z| Sert Filter Text to What-If Forecast OQutline
EH s Y - @ :
Data - All - ¢ Columns =2 Analysis - Sheet M
Gi Sort & Filter Data Tools Forecast ~
ﬁ From File L
c b
oy
From Database * - - - -
— 1 3
R o - 1 + 100%
= am From Azure » From Table/Range

B
__('“E‘) From Online Services L _@ From Web
4

=
From Qther Sources 4 _ From Microsoft Query

B
Combine Queries 4 _¢. From QDBC

i

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the
connection string for your data source (without credentials, which are defined in the

credentials dialog box in the next step). Additionally, you can enter an SQL statement that
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will be executed right after establishing a connection to the data source. Click OK.

From ODBC

Data source name (D5N)

Devart ODBC Driver b

4 Advanced options

Connection string (non-credential properties) (optional) G

SQL statement (optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (optional)

(None) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.
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ODBC driver X
Default or Custom < dsn=Devart ODBC Driver
. Use a username and password to access a data source with an ODEBC driver,

Windows

User name
Database myusername

Password

SR NeREeE

Credential connection string properties (optional) (0

Back Cancel

If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom ¢'d5”: evart ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (O
Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.
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O X
Navigator
P| | emp [2
Select multiple items EMPNO  ENAME J0B MGR HIREDATE SAL
Display Options = [ 7369 SMITH CLERK 7502 17.12 1980 0:00:00
~
B detoi 7499 ALLEN SALESMAN 7693 20.02.1981 0:00-00
etal
~ 7521 WARD SALESMAN 75093 22.02.1981 0:00:00
B detail with_constr.. 7565 JONES MANAGER 7839 02.04.1981 0:00-00
B detail2 7654 MARTIN SALESMAN 7558 25.09.1981 0:00:00
M dos 76598 BLAKE MANAGER 75839 01.05.1981 0:00-00
B emp 7782 CLARK MANAGER 7539 09.06.1981 0:00:00
i 7788 SCOTT ANALYST 7566 13.07.1967 0:00:00
E emp_tranaction_s...
¥ 7839 KING PRESIDENT null 17.11.1981 0:00:00
= empty_master £ >
Select Related Tables Load - Transform Data Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further
work with it.

H ©- Book? - Excel Evgeniy Lemeshov O X

File Hom | Inser | Page | Form | Data | Revie | View | Help | Table Design | Query Q Tell me S Share

Al - f A v
A B C D E F G H -
M emeno B enavie B 1oB BAmcr Bl HIREDATE Bl sa. B3 comm B pepio S
2 | 7369 SMITH CLERK 7902 17.12.1980 0:00 800 20
3 7499 ALLEN SALESMAN 7698  20.02.19810:00 1600 300 30
4 | 7521 WARD SALESMAN 7698  22.02.19810:00 1250 500 30
5 7566 JONES MANAGER 7839  02.04.19810:00 2975 20
6 7654 MARTIN  SALESMAN 7698  28.09.19810:00 1250 1400 30
7 7698 BLAKE MANAGER 7839  01.05.19810:00 2850 30
8 | 7782 CLARK MANAGER 7833 09.06.19810:00 2450 10
9 7788 SCOTT ANALYST 7566  13.07.19870:00 3000 20
10| 7839 KING PRESIDENT 17.11.19810:00 5000 10 |
Sheet8 | Sheeti | ® 1 3
/A = mm | 5 A4 o

Connecting Excel to MySQL with Data Connection
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Wizard (Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has
already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.
2. In the opened dialog, select ODBC DSN and click Next to continue.
3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to MySQL with the Query Wizard

You can use this option to create a simple query for retrieving data from MySQL to Excel via
ODBC driver.

1. Open Excel, in the main menu, click the Data tab.
2. Click the From Other Sources dropdown menu, and then click From Microsoft Query.
3. In the appeared dialog, you can choose the data source you want to connect to.

4. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.
. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.

. Select Return Data To Microsoft Excel and click Finish.

0 N O O

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

9. The required data is successfully imported to Excel.

Connecting Excel to MySQL with Microsoft Query
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You can use this option to create a more complex query for retrieving MySQL data to Excel
via ODBC driver.

1. Start Excel, click the Data tab.

2. In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

3. In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC MySQL). Uncheck Use the Query Wizard to Create/Edit Queries
and click OK.

4. Now you can select the tables you want to add to your query. When you finish, just click
the Add button.

5. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to MySQL with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data
models. To load the required data, do the following:

1. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.

2. In the opened window, click From Other Sources.

3. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

4. In the Specify a Connection String window, click the Build button.

5. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC MySQL), and then click Next.

6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).

7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.
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4.5

451

Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to MySQL from SQL
Server Management Studio using ODBC Driver for MySQL.

¢ Creating a Linked Server

¢ Troubleshooting in SSMS

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback

Reserved.

Creating a Linked Server

Requirements
In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN

e The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysW OW64\odbcad32.exe.

e ODBC Driver for MySQL and SQL Server must be installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to MySQL from SQL Server Management
Studio using ODBC Driver for MySQL

You can use the Microsoft SQL Server Management Studio to connect your MySQL data to
an SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as MySQL
and merge them with your SQL Server database. You can create a linked server with one of
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these methods: by using the options in the Object Explorer or by executing stored
procedures.

Below are major advantages of using SQL Server Linked Servers to connect to MySQL.:

1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the

organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to MySQL

You can follow the steps to create a linked server for MySQL in SQL Server Management
Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.
2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.
3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.
e Under Server type, select Other data source .
e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.
¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for

MySQL . Alternatively, you can input the ODBC Driver connection string in the Provider
field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access MySQL databases through SQL Server.

Retrieving Data From MySQL

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it
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Object Explorer * I x
Connect~ ¥ *¥ (VI
= @ EVGEMIYL\SQLEXPRESS (SOL Server 14.0.1000 - C
Databases
Security
= Server Objects
Backup Devices
= Linked Servers
B Providers
@8 ADsDSOObject
wE MSDAOQSP
wh MSDASQL
wh MSOLAP
wE MSOLEDBSQL
wh search.CollatorDs0O

In the appeared Provider Options window, enable the Allow inprocess checkbox:

@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers — O
e e IT Script « ﬂ Help
& General

Provider options:

Enable MName

U
U
[]

[Cynamic parameter
MNested queries
Level zero only
Allow inprocess

Maon transacted updates
Index as access path
Disallow adhoc access
Supports "Like’ operator

Lienlemed mmmamen s amimem dhin messicd e

Create a new Linked Server
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Object Explorer * I X
Connect~ ¥ ¥ VIS
= @ EVGEMIYL\SQLEXPRESS (SCL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices

c

Providers ( Mew Linked Server...
Triggers Start PowerShell
Replication
PolyBase Reports ’
Management Refresh

HEvent Profiler

£

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

H New Linked Server = O *
Selecta page HSGI‘iDt"ﬂHeIp
# General
& Security
& Server Options b
Server type:
() 5QL Server

(®) Other data source

Pravider: Microsaft OLE DB Provider far ODBC Drivers w

Product name:

Data source:

Location

| |
| |
Provider string: | |
| |
| |

Catalog

Connechon

Now you need to input the Linked Server name, e.g. MYSQL. In the Product Name and Data
Source fields you need to indicate the System DSN that you've previously created - more info
on System DSN setup can be found here.
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X new Linked server = x
esincta pegn T Script v (@ Hebp
& General
& Security
& Server Options Linked server: MYSGL

Server type:

() SGL Server

(@) Other data source

Provider: Microsoft OLE DB Provider for ODBC Drivers w

Product name: |Devart QDBC Driver for MySQL |
Data source: ||'~'h'SOL |
Provider string: | |
Location | |
Catalog | |

Connechon

The MySQL tables are already available to be fetched. To query the linked server, click New

Query in the toolbar:

File Edit View Project SOL Complete Tools Windoy

i@-o|8®-n-2 ¥ | B New query B R &
2 | | b Execute
L
Object Explorer * 0 X
Connect~ ¥ ¥ G -

= E EVGEMIYLA\SQLEXPRESS (5QL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
:
Providers
H ORACLE
B rPosSTGRESQOL
B saute

BEEEE

Enter your SQL query in the editor window and click Execute to run the query:
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45.2

LQ SQLQuery1.sql - EVGENIYL\SQLEXPRESS.master (sa (54))* - Microsoft SQL Server Management 5t...  Cuick Launch (Ctrl+0) Pl = 0O x
File  Edit View Query Project SOL Complete Tools Window Help
fe-o|f- Ml Brewawey BRSSO XIA][D-0 | B -1

i |
b
i

4l

“f | master - | P Execute v ES | i fe i—“||m';5|mr:|| ==
Object Explorer 50LQuery1.sgl - E..5.master (sa (54))* + X _
Connect~ ¥ *¥ ¢ » S|SELECT * FROM [MYSQL].[mydactest]..[emp];| +
Fs
B AmMAZON REDSHIFT ~ B
B ase
B BIGCOMMERCE v
B Dynamics 00% -
B FReBRD B Resuts @l Messages
B FRESHBOOKS ENAME  JOB MGR  HIREDATE SAL COMM DEFT A
B INTERBASE 1 SMITH  CLERK 7902 1980-12-1700:00:00.0000000 800 NULL 20
H MAGENTO 2 ALLEN  SALESMAN 7633  1981-02-20 00:00:00.0000000 1600 300 30
B MAILCHIMP 3 7521 WARD  SALESMAN 7698  1981-02-22 00:00.00.0000000 1250 500 30
H MoNGODE 4 7566 JONES ~ MANAGER 7839  1981-04-0200:00.00.0000000 2975 NULL 20
B Ms QL SERVER 5 7654 MARTIN ~ SALESMAN 7698  1981-09-28 00:00:00.0000000 1250 1400 30
= § mvsal 6 7698 BLAKE ~ MANAGER 7839  1981-05-0100:00.00.0000000 2850 NULL 30
Catalogs 7782 CLARK  MANAGER 7839  1981-06-09 00:00.00.0000000 2450 NULL 10
B NETSUITE 8 78 SCOTT  ANALYST 7566  1987-07-1300:00.00.0000000 3000 NULL 20
B ORACLE 9 7839 KING PRESIDENT NULL  1981-11-1700:00:00.0000000 5000 NULL 10
| posTcRES] 10 7844 TURNER SALESMAN 7638  1981-03-08 00:00:00.0000000 1500 0O 30
o 11 7876 ADAMS  CLERK 7788 19870713 00:00:00.0000000 1100 NULL 20
12 7900 JAMES  CLERK 7698 19811203 00:00:00.0000000 950 NULL 30
= § saL azure ———— = — &4
8 saute I 2

As a result, you can see the contents of the selected table retrieved directly from the MySQL
account you are connected to.

See also
¢ Troubleshooting SSMS

© 2015-2024
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Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

properties:
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-
. Compenent Services

Console Root
a 0 Component Services
4[] Computers
a & My Computer
» [o] COM+ Applicatio
[ -] DCOM Config
& [2] Running Processe
[ fj] Distributed Trans:
[ E Event Viewer (Local)
3 Q.,, Services (Local)

Windo.., Windows... Windows R.. Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo.,..  Windows.. WMIPro.. WMIProvi.

s & & &

Micresoft.... Microsoft.L... MicrosoftV... Microsoft....

ApplD
MMC (ALY MSMDPP - MsRdpSess...
Applicati.. LIZE

¥ & & &

MSTTS MahimicSe... MAP Agent Map Elevated
DecObj Cla.. Service COM class
NCLUA NDFAPI netman netprofm

¥ & & @&

NetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions »

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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-

MSDAINITIALIZE Properties

| General | Location | Securty | Endpoirts | Idertity |

(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

(71 Use Default

i@ Customize

Launch and Activation Permissions

Corfiguration Pemissions

Leam more about setting these properties.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions

available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are

connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
11D1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ N
. Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FD7AB29} S

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

You can take or assign ownership of this object f you have the required permigsions or privileges.

Current owner:

< - s i = iy et o -

Change ownerta:

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At
SRRRRRRRATY

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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4.6

-

-
. Permissicns for {2206CDE0-19C1-1101-89E0-00C04F... M

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

ok ] [Cance 7] [ oy

After this you should be able to edit MSDAINITIALIZE security settings .

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:
"Cannot create an instance of OLE DB provider"
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Using in OpenOffice and LibreOffice

Connecting to MySQL from OpenOffice and LibreOffice
using ODBC Driver for MySQL
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The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access MySQL data from Open Office Base or
LibreOffice Base — desktop database management systems. Note that the Windows version
of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for
MySQL, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Apache i ™
€5 OpenOffice™ 4

‘E Text Document; Drawing
Spreadsheet EE] Database
Presentation E Formula

@ Open... = |_r/_| Templates..

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit

] New
2 open..

Recent Documents

View [nsert

Ctri+ 0

@

Wizards

Close
Ctrl+5
Ctrl+5hift+5

Save

o O &

Save As..
Save All

Reload
Versions...
Export..

Export as PDF...
Send

]

"

2. In the Database Wizard dialog box, click Connect to an existing database, select

Farmat

M FWE B E W

T

Table

Tools
Text Document Ctri+M
Spreadsheet

Presentation

Drawing

Database

HTML Document
XML Form Document

Master Document

Formula
Labels

Business Cards

Templates and Documents

Window Help

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name
of your data source into the field, e.g. ODBC Driver for MySQL, or you can click Browse,

double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection
3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for MySQL and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.
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£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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{8 New Database10.odb - OpenOffice Base — O X
File Edit View |nsert Tools Window Help X
BB W EB-e)iEmBE g

] Use Wizard to Create Table...
[# create view..

[Ei Create Table in Design View... Description

=

‘ crgrid_test G MNone ~
=] dbxmda_blob

horme default_values

dept

detail

Reports detail_with_constraints

detail2
9 mydactest.emp - New Database103 - OpenOffice Base: Table Data View - O b4

Eile Edit View |nsert Tools Window Help

d || =2 Cel i F- NIRRT v Hy
EMPNO |  ENAME | JOB | mer | HIREDATE SAL COMM DEPTNO
_ |7389 SMITH CLERK 7902 17.12.80 00:00 800 20
_|7as8 ALLEN SALESMAN 7698 20.02.81 00:00 1600 300 30
s WARD SALESMAN 7608 22.02.81 00:00 1250 500 30
_ |7s66 JONES MANAGER 7839 02.04.81 00:00 2975 20
__|7654 MARTIN SALESMAN 7698 28.00.81 00:00 1250 1400 30
_ |76e8 BLAKE MANAGER 7339 01.05.81 00:00 2850 30
I CLARK MANAGER 7839 09.06.81 00:00 2450 10
_ |77ss SCOTT ANALYST 7566 13.07.87 00:00 3000 20
7839 KING PRESIDENT 17.11.81 00:00 5000 10
_|7844 TURNER SALESMAN 7698 08.09.81 00:00 1500 a 30

7. To create an SQL query, click Queries in the Database pane, then click Create Query in

SQL View...
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MNew Database.odb - OpenOffice Base -

Eile Edit Wiew [Insert Tools Window Help

B3 - E-@y ]
[ Create Query in Design View... Description
\E= (& Use wizard to Create Query Create a query entering an SQL statement dirs

Tables |§&|. Create Query in SQL View... |
F
EEE

i

ﬁ

Forms |

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

£ New Database10.0db : Query1 - OpenQffice Base: Query Design = O *
Eile Edit View Insert Tools Window Help
I BT I A

B B @ w2 R T

|
EMPNG | ENAME | JoB | MGR |  HIREDATE SAL COMM DEPTNO

7369 SMITH CLERK 7302 17.12.80 00:00 800 20 ‘

7499 ALLEN SALESMAN 7698 20.02.81 00:00 | 1600 300 30

7521 WARD SALESMAN 7698 22.02.81 0000  |1250 500 30

7566 JONES MANAGER 7839 02.04.31 00:00 2975 20

7654 MARTIN SALESMAN 7698 28.09.81 0000 1250 1400 30

7698 BLAKE MANAGER 7839 01.05.8100:00 2850 30

7782 CLARK MANAGER 7839 09.06.8100:00 2450 10

7738 SCOTT ANALYST 7366 13.07.87 00:00 3000 20 )
Record [10 [ of 14 [l 1]
SELECT * FROM emp; 4
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4.7 Using in PHP

Connecting to MySQL from PHP using ODBC Driver for
MySQL
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PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing MySQL via ODBC. The script connects to
MySQL database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$obBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for MysSQL};Se

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($0ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

while (odbc_fetch_row($Recordset)) {
$result = odbc_result_all($RecordSet, "border=1");
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odbc_close($0DBCConnection);
7>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.
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Using in Power Bl

Importing MySQL Data into Power Bl Through an ODBC
Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as MySQL, you can use a corresponding
ODBC driver.

This tutorial explores how to connect to MySQL and import data into Power Bl Desktop using

an ODBC driver. It is assumed that you have already installed and configured a DSN for

ODBC driver for MySQL.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for MySQL

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the MySQL data into Power Bl for analysis, select the needed table and click Load.
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4.9 Using in Python

Installing the ODBC Driver for MySQL

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to

work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download

the appropriate installer and run it. You will also need to install the pyodbc module — the

easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for MySQL. To use the ODBC driver as
a translation layer between the application and the database, you need to configure it by

following the installation instructions.

Connecting to MySQL from Python using ODBC Driver

for MySQL

Here’s an example to show you how to connect to MySQL via Devart ODBC Driver in Python.

First we import the pyodbc module, then create a connection to the database, insert a new

row and read the contents of the EMP table while printing each row to the Python interactive

console. To execute the script, you can type the code directly in the interactive console or add

the code to a file with the .py extension and run the file from the command prompt.

Step 1: Connect

import pyodbc

cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for MySQL};User ID=myuseri

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the

database. The script inserts a new record to the EMP table.

cursor = cnxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO,

Step 3: Execute query

ENAME, JOB, MGR) VALUES (535,
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The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.

cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:

print (row)

row = cursor.fetchone()
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Using in QlikView

Connecting to MySQL from QlikView using ODBC Driver
for MySQL

This tutorial describes how to connect and configure QlikView to retrieve data from MySQL for
further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data

sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or

later.

To connect to an ODBC data source from QlikView using our driver for MySQL, perform the
steps below:

1. Open the QlikView client application and click File > New. Close the Getting Started
wizard and open File > Edit Script (CTRL+E).
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@ qlikview x64 Personal Edition - [av1]

{ File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help

i | New ctri+N || B | | v | (2| @) 52 B K clear | @ Back @ Forward | & Lock & Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites 4
=l | save Ctrl+5
Save As.. F12

Save Link

Mail as Attachment...

1]
i]

are. as a LInk

vid viL (=100 4
2 P Ctr|+P
Print Sheet...
Source Control »
Export 4
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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File Edit Insert Tab Tools Help

-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main

v |22 =

3 e

[GET

@ Connect to Data Source s

User ID Pazswond

|m_l,.lid | | sesee| |

Data  Functions ‘arables Settings

[ atabaze

| apec v Connect...

[ Forze 32 Bit Select...

[1ata from Files =

[ Relative Paths
[JUzeFTR

Data Sources

Canecel

Help

i}
Devart ODEC Drriver for ASE
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
Devart ODBLC Driver for bMagento
Devart ODBC Diiver for MailChimp
Diewart ODBC Diriver for MySEIL
Devart ODEC Driver for MetSuite
Dewart ODBC Driver for Oracle
Drewart ODBC Drriver for SOL Azure
Devart ODBC Driver far SOLite
Mesweart CNRC Ciniver for vRacs

[ Show User DSMs

Test Connection...

0k Catcel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.

@ Edit Script [Ch\Users\EvgeniyL\Documents\new.qvw®]

File Edit Insert Tab Tools Help

=} Reload #Debug | = S| 4 -2 B O [0 41 2 Tabs Main v |25 =
GET
ODBC COMNECT TO [Dewart ODBC Driwver for MySQL]:
SELECT * FROM my:lac:test.emp;|
Data  Functions Warables Settings
Database Data from Files
| ODBC w Connect... [ Relative Paths Table Files...
[JuseFTP TR ;
[ Foree 32 Bit Select... Elfissi=en (=
Wwieb Files...
Field D ata...
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Sheet Properties [Main]

General Fields  Objects Securty Triggers
Awvailable Fields

COMM

DEPTNOD
EMPNO
ENAME
HIREDATE
JOB

MGR

SAL

Add =

Add All =

< Remove

Fields Displayed in Listboxes

4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and

clicking Add. When you are ready with your SELECT statement, click OK. You will get

back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.
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@ Create Select Statement - a >
Data zource |De\l'art QDBC Driver for MySQL | Conrect...
Databaze | rmypdactest w | Driver...
Cwmer Support...

Databaze Tables Fields | Text Order i |
Oshowal  [detl ~ I ~
Tahles detail2 COkk
Views detail_with_constraints DEPTHO
dos ERPHO
L Synenyms ENAME v
System Tables emp_tranaction_safe | L_tumrmaws
[ dliases armnhn_mastar ¥ | ] Show lcon for Key Fields
Script  Table Column:  Preview  Blobs
SOL SELECT * (®) Colurnin
FROM mydactest.emp; ) Row
() Shiuctured
[ Preceding Load
Add

5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.

) QlikView x64 Personal Edition - [CUsersh ODBC\ Documentsh 1.gvw™]

File Edit View Selections | Layout | Settings Bookmarks Reports  Tools  Object Window  Help

ARREoN = =T 5l | =) __| Add Sheet... '75 Kl Clear ~ | (& Back (2 Forward | (5 |
. W Promote Sheet
Main
lid . r ¥l Demote Sheet
1 408 #ll Remove Sheet
i £ |ld) Select Fields..
3 A1 New Sheet Object v || [B] List Box...
5 5 o
6 74 Rearrange Sheet Objects Zi|| Statistics Box...
; #1, Adjust Off-Screen Objects E| Multi Box..
5 Align/Distribute v [ Table Box..
10 —
f Chart...
1 1 = Iy
12 it =] Input Box...
ti v| Current Selections Bo...
15 l;] Button...
16 3
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@, Qlikview x64 Personal Edition - [Ch\Users\EvgeniyL\Documents\new.qvw®] S O >
i File Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help - 83
HRNEEN™ (= TRERE N, el el i gk R 2| -y|9)vs?§ﬂ<]clear‘|@83ck 2) Forward |, (& Lock J"Unlock

Main

S
COMM DEPTHNO  EMPNO EMNAME HIREDATE JOB MGR SAL
0 30 7844 TURMER 108.09.1981 0:00:00 SALESMAN 7658 1500
300 30 74595 ALLEN 20.02.1961 0:00:00 SALESMAN 7695 1600
500 30 7521 WARD 22.02.1981 0:00:00 SALESMAN 7698 1250
1400 30 7654 MARTIN 28.09.1981 0:00:00 SALESMAN 7698 1250
10 7782 CLARK 109.06.1981 0:00:00 MANAGER, 7839 2450
10 7835 KING 17.11.1961 0:00:00 PRESIDENT = 5000
10 7934 MILLER 23.01.1982 0:00:00 CLERK 7782 1300
20 7369|SMITH 17.12,1980 0:00:00 CLERK 7902 800
20 7566 JONES 02.04.1961 0:00:00 MANAGER. 7839 2975
20 7788 5COTT 13.07.1987 (:00:00 ANALYST 7566 3000
20 7876 ADAMS 13.07.1987 0:00:00 CLERK 7788 1100
20 7902 FORD 103.12.1981 0:00:00 ANALYST 766 3000
30 7658 BLAKE 01.05.1%81 0:00:00 MANAGER. 7835 2850
30 7900 JAMES 103.12.1981 0:00:00 CLERK 7698 950
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Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for MySQL as a
translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the
Advanced Settings tab and select ver 2.x from the obBc Behavior dropdown.
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General Advanced setfings License About

Meta Data
Connection
— -
Compatibility
QDBC Behavior Ver 2, e
String Types Default b

|Use Local Regional Settings when converting to string

[]mumbers [ ]Dates and times

Test Connection - Cancel
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412 Usingin Tableau

This section describes how to establish and troubleshoot a connection to MySQL from
Tableau using ODBC Driver for MySQL.

e Using in Tableau

e Troubleshooting in Tableau on macOS
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412.2

Using in Tableau

Importing MySQL Data Into Tableau Through an ODBC
Connection

This article explains to establish and ODBC connection to MySQL from Tableau Desktop.
Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
and create meaningful reports to get actionable insights. With Tableau Desktop and our suite
of ODBC drivers, you can connect to various relational and non-relational databases, both
cloud and on-premise.

1. Run Tableau Desktop.

2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured
for MySQL. Alternatively, if you have not created a DSN, you can choose the Driver option
and select Devart ODBC Driver for MySQL from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in MySQL.

. You should see the list of all tables you have access to in the connected data source.

© 00 N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the
table.

10.Hit Update Now to retrieve and display the data.
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Troubleshooting in Tableau on macOS

Troubleshooting ODBC Connection in Tableau on
macOS

The iIODBC driver manager incorrectly handles the SQL_WCHAR and SQL_WVARCHAR
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ODBC data types. To work with these data types in Tableau, create a Tableau Datasource
Customization (. tdc) file in 'Users\[your name]\Documents\My Tableau Repository
\Datasources\' — for example, devart-mysql.tdc, and add the following capabilities to the file:

<?xml version="'1.0"' encoding='utf-8"' 7>

<connection-customization class='genericodbc' enabled='true' version="1.0"'>
<vendor name='MySQL' />
<driver name='Devart ODBC Driver for MysqQL' />

<customizations>

<customization name='CAP_ODBC_BIND_SUPPRESS_WIDE_CHAR' value='yes'
</customizations>

</connection-customization>
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